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1. Introduction

This document describes the implementation of a battery-operated Bluetooth® Low Energy NFC
Smart Lock for the hospitality market. This document does not replace the PN7462AU or QN9021
datasheets and respective application notes. Please refer to the datasheets for detailed information
of the ICs. This document also describes the process of firmware upgrade for both the PN7462 and
QN9021 (QS9322 module) as well as for the implemented demonstration functionality.

The Smart Lock KIT hardware design consists of two PCBs and incorporate the following
main IC components:

e PN7462AU — all-in-one full NFC application controller with freely programmable
puController

(PN from now on)

e QN9020 — for Bluetooth Low Energy communication (QN from now on)

e PCF8883T — for capacitive wake up of the application processor circuitry
(PN7x62)

e NX5P2553 - precision adjustable current-limited power switch

The PN and the QN ICs communicate with each other by means of serial communication
over a UART interface.

Each of the micro-controllers contains its own firmware which performs the required

actions depending on the origin of the unlock token. The token can be delivered to the
lock in two ways:

e over RFID — with the help of an MIFARE DESFire 1ISO14443 Type A card or via
an Android based phone using HCE.

e over Bluetooth Low Energy — with help of any Bluetooth Low Energy compliant
device

In this document the term ,MIFARE DESFire card” refers to a MIFARE DESFire IC-
based contactless card.
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2. Smart Lock KIT Package Content

OM27642 Smart Lock KIT
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Fig 1. OM27462NBR Smart Lock module, power cable, programming cable, touch sensor plate,
set of demonstration cards
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3. Smart Lock Module Hardware
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Fig 2. OM27462NBR Smart Lock module consisting of PN7462AU core module V1.2 and the 40mm @
base board NFC- Bluetooth Low Energy Smart Lock V1.1

The core module — stack on board contains all necessary blocking capacitors, XTAL, 2
status LEDs and the antenna EMC filter.

The Core module is designed for general purpose use therefore all power supply options
(e.g. internal/external LDO etc.) are configured on the base board. The core Module /
stack on approach was taken in order to create a high density low PCB area
implementation.
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3.1 Smart lock system block diagram
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Fig 3. Main building blocks
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Fig 4. OM27462NBR NFC- Bluetooth Low Energy Module with PN7462 stack on core module

Figure 4 shows the functional block diagram of the Smart Lock module including the
main components used.
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4. Schematics
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Fig 5. Base board schematic part 1
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4.1 Base board schematics continued
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Fig 6. Base board schematic part 2
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4.2 Core Module schematics
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Fig 7.
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4.3 Antenna matching

UM11038

OM27642 Smart Lock KIT

The antenna matching of the Smart Lock main PCB is shown below. The EMC filter is
part of the stack-on core Module. The base board consists of the matching circuit with
the damping resistors and the serial and parallel matching capacitors.
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Fig 9. Antenna matching components on the base board

Please Note: high resolution schematics are available as PDF files in the download
section under manufacturing data here: www.nxp.com/demoboard/OM27462NBR
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5. Base board connectors
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Fig 10. Base board connection description

1-3V power
supply

6. Getting started

6.1 Setting up the hardware module
1) Connect the Touch sensor plate as shown in fig. 1.
2) Connect a DC power source (2V-3.3V) to the pins labeled “BAT” (see fig. 1)

6.1.1 Smart Lock power connection

As the Smart Lock is intended to be operated by a single cell battery (e.g. CR2

~780 mAh or CR123 ~1,450 mAh) with a nominal voltage of 3V (typically ~2.5 V
depending on load current). An ultra-low-power step up converter which operates down
to below 1 V input voltage is used to generate 3.3 V circuitry supply.

Fig 11. Power Supply Connector location on Smart Lock base board
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7. Smart Lock operation

The Smart Lock KIT comes with pre-configured functionality.
7.1 Operating the Smart Lock using the demonstration cards

1) Configure Room 201 by bringing the “Lock Configuration Room 201" card in close
proximity of the module. Wait for lock configuration sequence completion which is
indicated by the RGB LED and on-board buzzer while active.

2) Present “Room 201 ACCESS Guest 1" card or “Room 201 ACCESS Guest 1 re-issued”
card in close proximity of the module. If the card is valid and accepted, LED will light up
green and the buzzer will give a brief beep indicating acceptance. If an invalid card is
used, the LED will light up in red and the buzzer will beep 3 times.

Note: By presenting the “Room 201 Guest 1 re-issued” card, the “Guest 1” card will be
invalidated and not accepted further until you re-configure Room 201 with the respective
configuration card.

3) In order to set the Smart Lock to an alternative room / guest, re-configure the lock to

room 202 / guest 3 with the respective “Lock Configuration Room 202" card. Guest 3 will
be accepted whereas Guest 1 — Room 201 cards are declined.

SMART Lock DEMO [N)}(®) SMART LOCK DEMO [N)/{®)

& LOCK CONFIGURATION & LOCK CONFIGURATION
-G -ﬁ
\®%) ROOM 201 \®O") ROOM 202
(Guest 1) (Guest 2)
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u i_ @everywhere a AR @everywhere

MIFARE DESFire 2568 MIFARE DESFire 2568

SMART LOCK DEMO [RN)(®)
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ACCESS Guest 2

i :: @everywhere
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Fig 12. Set of demonstration cards
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7.2 Operating the Smart Lock using the mobile Smart Lock App

Download the “NXP SMARTLOCK" app from Google Play Store and install it on your mobile
NFC enabled Android device.
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All information provided in this document is subject to legal disclaimers. © NXP B.V. 2018. All rights reserved.

User manual
COMPANY PUBLIC

Rev. 1.1 — 11 October 2018 13 of 38
407611



https://play.google.com/store/apps/details?id=com.nxp.smartlock

NXP Semiconductors

UM11038

OM27642 Smart Lock KIT

@ et

LOCK CONIFG

@

OPEN DOOR

OBuntoty

CARD CONFIG

Glick to configure: SMARTLOGK 0201

© s10206 21:22

CONFIGURE ROOM 202

Click LOCK CONFIG to set
1) room number
2) date and time

Lock will optically and
acoustically confirm the
modifications.

~ 10w an22

Nxa SMART LOCK DEMO

3O 942

Nxa SMART LOCK DEMO

LOCK CONIFG

L]

OPEN DOOR

QBlstogt
CARD CONFIG
Current reserved room

_~. Room 201
Reserved from
Reserved 1l

6.10.2016,21:00
9.10.2016,13:00

Click the Key to unlock: SMARTLOCK 0201

OPEN DOOR menu (start
screen)

After starting the app the above
menu shows the reserved room.

pr SMART LOCK DEMO

Nxa SMART LOCK DEMO
o @

Available Rooms

Reserve a room from the list below to continue,

oner | @

erywhere

QBuetonth’

Q Reserve Room 202

-~
Room 201
(= BHEDAD > © 7 october2016 1400
/r-q\ Room 202 >© @ 10 October 2016 13:00
& ramare. >

Reserve another available room
by pressing the room symbol in
the right down corner of the
Reserved room menu.

O RO = RuMsn

pr SMART LOCK DEMO

oo D
LOCKCONIFG ~ OPENDOOR  CARDCONFIG
Current reserved room
™ foom 202 07/10/2016 15:00

Reserved from
Reserved ti 10/10/2016 13:00

TAP HANDSET ON TO LOCK

The Room is now changed to
Room 202 with the date/time
stamp set upon purchsed.

Open the door by

1) NFC: present mobile phone to
NFC antenna even when the key
is greyed out.

LOCK CONIFG

The Room
202 with the date/time stamp set
upon purchsed.

@everyuners

Current reserved room

A~ Room 202
K= Reserved from 07/10/2016 15:00
Reserved till 10/10/2016 13:00

TAP HANDSET ON TO LOCK

2) Bluetooth® Low Energy: Click
on the key button once it appears
green and the Lock number is
displayed underneath the key
symbol

Reserve another available room
by pressing room symbol in the
right down corner.

O MDD = R B1521

pr SMART LOCK DEMO

)

OPEN DOOR

O Biuetoot

CARD CONFIG

is now changed to Room

Fig 14. Quick reference for Smart Lock App

By clicking on the displayed
dates or times respective
screens for the both will appear
and can be easily adapted.
BUY NOW will create a new
key token on the mobile
device.

Press CONTINUE after
successful purchase.

=] 30 wam222

pr SMART LOCK DEMO

@ >

LOCK CONIFG

©Bluetogth'

OPEN DOOR CARD CONFIG

Click to configure: SMARTLOCK 0201

(© e.10.2016 21:22

CONFIGURE ROOM 201
CONFIGURE ROOM 202

Click LOCK CONFIG to set
1) room number
2) date and time

Lock will optically and
acoustically confirm the
modifications.

UM11038

All information provided in this document is subject to legal disclaimers.

© NXP B.V. 2018. All rights reserved.

User manual
COMPANY PUBLIC

Rev. 1.1 — 11 October 2018
407611

14 of 38




NXP Semiconductors UM11038

OM27642 Smart Lock KIT

8. Firmware design description

8.1 Power saving
As RFID and Bluetooth Low Energy Smart Lock Reference Design is powered by a
battery it is important that we consume as little energy as possible. The PN spends most
of its time shut down and can be woken in multiple ways:
e over proximity touch sensor switch
e over micro-switch — external input
e by QN (Bluetooth Low Energy module)

QN is powered all the time and sends out Bluetooth Low Energy advertisements
periodically so that Bluetooth Low Energy devices can discover the lock. Between
Bluetooth Low Energy advertisements broadcasts it is running in low power mode. In this
mode most peripherals are switched off and QN is running on

32 kHz clock to support RTC. PN can wake up QN from low power mode any time by
interrupt on GPIO when PN requires the current time from QNs RTC to check the token.

8.2 Interaction between PN and QN when token is delivered over RFID

When the token is delivered over RFID the PN gets powered up by means of proximity
sensor or switch and starts polling for RFID cards or NFC phones with HCE. If a device is
found it tries to retrieve the access token. After successful retrieval of the token, the
validity of the token must be checked. As time and date is required to do so, the PN must
wake up the QN to retrieve the current date and time from QNs RTC. After date/time is
retrieved from the QN and the token is deemed valid the process of unlocking the door is
started.

8.3 Interaction between PN and QN when token is delivered over
Bluetooth Low Energy
When the token is delivered over Bluetooth Low Energy, the QN powers up the PN after
a connection was established successfully between the QN and the Bluetooth Low
Energy client. Commands to retrieve the token are issued by the PN. After successful
retrieval of the token, validity of the token must be verified. If the token is deemed valid
the process of unlocking the door proceeds.
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9. Communication protocol between QN and PN

Communication between QN and PN is done using two GPIO lines and UART
communication (115200 bps and data format 8N1).

The GPIO lines are used to power the PN (in case a Bluetooth Low Energy client
connects) or to wake-up QN (in case a card or phone is presented to the PN via NFC).

The UART is used to transfer data for

e Handshake
e Data exchange

Data is transferred using a single character command, a 2-byte length indicator and the
data bytes. All data is sent using little endian format.

Only during the handshake phase the PN sends repeatedly a single character ‘P’ without
any additional bytes until QN responds.

PN_3V3 v +3.3V
- BLE_DETECT
ﬁg P12 L
PN_BLE_Detect = .
GPIO10 =i NPT [i] =
PN7462 @ BLE_RX
P17
Core Module ATX B o™ .
L
BLE_TX
ATY A 1 PO.O
"-\‘I
BLE_OUT
power | =1 P10
Trigger |
I+3.3v
Fig 15. Communication interface between QN and PN
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According to the use cases NFC and Bluetooth Low Energy communication, two
scenarios exist to start the communication between QN and PN

10.1.1 NFC Transaction

In this use case the PN is powered up either by the proximity switch or the micro switch.
In both cases the PN has to wake-up the QN to leave low power mode and activate its
UART peripheral. Therefore, the PN triggers a GPIO interrupt using the BLE_DETECT

line. At the same time the PN sends ‘P’.

This procedure is repeated until QN responds with 'V’ and a 4-byte UNIX timestamp (little

endian).

BLE _DETECT

QN PN_TASK
State

BLE_RX

BLE_TX

1

IDLE

NFC_ACTIVE

Wait for next ‘P before protocol

NFC_ACTIVE
Wait for next command

V' + unix date

time

Fig 16. Communication procedure between QN and PN - details

Example:
PN ON
0x50 —
— 0x560400FB435E54
UM11038 All information provided in this document is subject to legal disclaimers. © NXP B.V. 2018. All rights reserved.

User manual
COMPANY PUBLIC

Rev. 1.1 — 11 October 2018
407611

17 of 38




NXP Semiconductors

UM11038

10.1.2 Bluetooth Low Energy Transaction
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In this use case QN will power PN using the BLE_OUT line after establishing the
Bluetooth Low Energy connection. After power on the PN will start the communication by
triggering the QN GPIO interrupt using the BLE_DETECT line. At the same time PN will

send ‘P'.

This procedure is repeated until QN responds with ‘O’ and a 4-byte UNIX timestamp

(little endian).

The following figure shows the whole procedure:

BLE_OUT

1

BLE_DETECT

IDLE

QN PN_TASK

NFC_ACTIVE

NFC_ACTIVE

Wait for next ‘P’ before protocol | Wait for next command

State

BLE_RX

BLE TX

‘0" + unix date

time

Fig 17. Bluetooth Low Energy Transaction - details

Example:
PN ON
0x50 —
— 0x4F0400FB435E54
UM11038 All information provided in this document is subject to legal disclaimers. © NXP B.V. 2018. All rights reserved.
User manual Rev. 1.1 — 11 October 2018 18 of 38

COMPANY PUBLIC

407611




NXP Semiconductors UM11038

OM27642 Smart Lock KIT

10.2 Data exchange

After the initial handshake data exchange may start. The following commands are
available:

e ‘'C: PN sends APDU command to QN (QN forwards data to the Bluetooth Low
Energy client)

e ‘A’ QN responds with response APDU
e ‘T PNsets RTCin QN
e ‘N’: PN sets a new Bluetooth Low Energy device name in QN.

e ‘D PN indicates QN that the transaction is finished and communication shall be
disconnected

All commands are followed by two bytes for length and then data. In case of 'T' command
the answer is the same as at power up ('O'<len><time>), but for 'C' command we return
'‘A'<len><data>:

PN ON
'C'<len><data> N
— 'A'<len><data>
Example:
PN ON
0x4308000102030405060708 —
— 0x4102009000
UM11038 All information provided in this document is subject to legal disclaimers. © NXP B.V. 2018. All rights reserved.
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11. Structure of the QN Firmware

111

UM11038

User manual
COMPANY PUBLIC

The QN firmware is built on NXP Bluetooth Low Energy library. This library implements a
proprietary profile which is optimized sending and receiving APDU commands. It
automatically splits data onto several Bluetooth Low Energy packets if necessary. In
addition, the library uses the Bluetooth Low Energy feature to send several Bluetooth
Low Energy packets in one communication interval to speed up communication.
All data is transferred using unacknowledged Bluetooth Low Energy packets:

e Write Commands (Bluetooth Low Energy client to QN)

¢ Notifications (QN to Bluetooth Low Energy client)

Data sheet QN902x: http://www.nxp.com/documents/data_sheet/QN902X.pdf
Application note: http://www.nxp.com/documents/application note/AN11664.pdf

The communication with PN is basically done by two modules:
e app_pn_task.c: The PN TASK handles the whole communication with the PN. It
controls the state, interprets the commands and starts/stops the communication
e pn_nfc.c: driver to communicate with PN. This module handles the low-level
functions to communicate with PN. It contains functions which run the context of
the GPIO interrupt as well as UART interrupt. In case of an event this module will
send a message to the PN TASK which will handle the event in a synchronous
way.
Note: In the download area only the binary files are provided.

src\app\pn\app_pn_task.c

The PN TASK has the overall responsibility to take actions and control the state of the
QN. This means that all input from PN (UART data but also GPIO wake-up events) is
converted to messages and sent via messages queues to the PN TASK.

To send messages to the PN TASK this module provides global functions which build
and send the appropriate messages.

From the QN point of view two events may start a transaction and thus the
communication with the PN:
e PN is woken up by proximity sensor or micro switch and wants to communicate
with QN. The handshake sequence may start immediately.
e A Bluetooth Low Energy client connects to QN. QN has to power on PN before
starting with the handshake sequence.

The PN_TASK basically uses three app states:

e PN_STATE_IDLE: QN advertises and uses low power mode. Sleep mode is not
possible since RTC must be powered. The task is waiting either for a Bluetooth
Low Energy connection or a wake-up event from PN via GPIO line.

e PN_STATE_BLE_ACTIVE: A Bluetooth Low Energy Client has connected and
subscribed to receive notifications from QN. In this state the PN_TASK acts as a
kind of proxy between the Bluetooth Low Energy client and the PN, meaning it
transfers APDU commands from PN to the Bluetooth Low Energy client and
APDU responses in the other direction.

e PN_STATE_NFC_ACTIVE: PN is powered up (e.g. proximity sensor) and wants
to read the current RTC value from QN. In this state no APDUs are exchanged
since those are handled locally between the PN and a NFC medium directly. Still
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the QN is ready to accept commands from PN like reconfiguring the device name
(e.g. room number is changed).

The main handlers in active state are the functions

. It processes messages sent from the pn driver and
thus evaluates the commands received from PN.
. It forwards response APDUs from the Bluetooth Low

Energy client to the PN

11.2 src\driver\pn_nfc.c
This driver is responsible for:
e wake-up QN in case PN wants to communicate
e poweron PN
e receive and evaluate data from PN, build messages from incoming data and
forward these messages to the PN TASK
e build and send messages to the PN

When PN starts a transaction (e.g. is powered due to proximity sensor) it will trigger a
GPIO interrupt on line BLE_DETECT. The GPIO interrupt handler calls

. This callback function processes the event and sends the
message PN_NFC_ACTIVATE_REQ to the PN TASK. Before it will block additional
GPIO events to avoid sending multiple messages ( ).

ATTENTION: To be sure that the QN OS Kernel is active, the library function
must be called. Otherwise the sent message could be processed
only after a considerable delay.

The PN_TASK will then activate the UART by calling the function

The original uart driver from the QN SDK is modified to work with pn_nfc.c. The define

activates a different receive mode in uart.c (in contrast to the original QN
SDK procedure). All characters being received via UART are forwarded via callback
function to pn_nfc.c:

During initial handshake phase all characters different from ‘P’ are being ignored (static
variable ). This shall filter possible spurious signals on the serial line when PN is
powered on.

processes all incoming data and assembles it to messages. After
having received a full message from PN it is forwarded to the PN TASK. It is then the
responsibility of the PN TASK to take appropriate actions.

If PN TASK wants to send messages to PN it uses the function

After the transaction is finished PN TASK it calls pn_nfc_power_off(). This will also
deactivate the UART to save power. In fact, the PN has to power off itself. The BLE_OUT
line is set to low, so it can retrigger power for the PN later on.
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Interaction with Bluetooth Low Energy Stack

NXP Bluetooth Low Energy Lib only needs few interfaces to exchange data with the
Bluetooth Low Energy Client. When the Bluetooth Low Energy Client sends a BLE write
command the function in file smx_task.c gets called. This
file is part of the proprietary profile.

In this function the PN_TASK is called in two places:
- When the Bluetooth Low Energy Client connects and registers to receive
Bluetooth Low Energy notifications the PN_TASK is activated by calling

- During normal operation the NXP Bluetooth Low Energy Lib collects data from 1
or more Bluetooth Low Energy frames. After the payload frame has been
received completely, the function

gets
called to forward incoming payload from the Bluetooth Low Energy client to the
PN_TASK.

In the opposite direction the PN_TASK calls function

in file smx.c. If necessary, the
data will be split automatically into several Bluetooth Low Energy frames and sent as
Bluetooth Low Energy notifications to the Bluetooth Low Energy client.

After a Bluetooth Low Energy disconnect sequence is completed (trigger via Bluetooth
Low Energy client or smartlock) the PN_TASK receives a PN_BLE_DISC_IND message

and the handler gets called. This handler checks
( ) whether a system reset is necessary (e.g. new device
name).

Since there are situations where the Bluetooth Low Energy connection is closed (eg
Bluetooth Low Energy Client disconnects) but PN activity is still not finished (eg lock
open/close ongoing), Bluetooth Low Energy advertising may not automatically be started
after a Bluetooth Low Energy disconnect complete event. Therefore the event handler for

in file usr_design.c and function will check
whether advertising is allowed by invoking

In this situation advertising has to be started manually after PN has finished its operation.
For the manual advertising start PN_TASK will call in file usr_design.c.

Bluetooth Low Energy Service definition
The file smx.h contains the definition for the UUIDs used in the Smart Lock application:

defines the service UUID. This UUID is also advertised. The smartphone
app is looking for devices advertising this service.

defines the characteristic to which the Bluetooth Low Energy client will
write to

defines the characteristic which will transfer data from QN to the
Bluetooth Low Energy client using Bluetooth Low Energy notifications. Therefore, the
Bluetooth Low Energy client has to subscribe at first to receive notifications.
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11.5 Smart Lock\Smart Lock .c
The file contains the main state machine for UART-to- Bluetooth Low Energy
communication. As described there are two main states:
1) power-on-handshake
2) data exchange

11.6 Power-On-Handshake
The sequence begins after Bluetooth Low Energy receives new connection in the
app_qgpps_cfg_indntf_ind_handler function which calls Smart Lock _power_on_pn to set
up the UART callback to wait for 'P' command. When something is received on the UART
the Smart Lock recived_pn_power_on is called to check if the command is correct and
in this case the current time is send back (Smart Lock _send_rtc_time) and the Smart
Lock enters state 2) — waiting for command - by setting up the correct callback to receive
data on UART
— Smart Lock _uart_wait_for_cmd.

If 'P' command is not received and a time-out happens the QN enters the sleep/advertise
cycle again.

11.7 Data exchange

11.7.1.1 Send data
Data exchange state is entered by calling Smart Lock _uart_wait_for_cmd to set up the
correct callbacks on UART to wait for command from PN. When the command header
(first 3 bytes) is received by the QN the function Smart Lock _uart_recive_cmd_header is
called and the command is checked if it is valid.

Valid commands are:
e 'C'-send data to the Bluetooth Low Energy client
e 'T'—settime of RTC

If a valid command is received the QN proceeds to read the <len> bytes of data from the
UART by registering a UART receive callback Smart Lock _uart_recive_cmd.

When the whole command is received the Smart Lock _uart_recive_cmd function sends
the data to the Bluetooth Low Energy client and sets up a time-out on Bluetooth Low
Energy if the client does not respond in case of a 'C' command.

The 'T' command sets the RTC to the time sent by PN — no Bluetooth Low Energy
communication is performed at this time.

11.7.1.2 Receive data
Data is received from the Bluetooth Low Energy client in the app_gpps_data_ind_handler
function. Which uses Smart Lock uart_transmit_add_data to store the fragmented
pieces of data to the UART RX buffer and Smart Lock _uart_transmit_reply to send the
data to PN after the entire package was received.
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12. Structure of the PN Firmware

PN firmware is split into two tasks:
1) CLIF — RFID task (implemented in smart_lock_clif.c)
2) HIF — UART task (implemented in smart_lock_hif.c)

The tasks are created in the appMain function in src/smart_lock.c.
Common code for retrieving the token and door opening is smart_lock_token.c.

12.1 Token retrieval

Token retrieval is done by smart_lock_retrive_token function from smart_lock_token.c. The
function uses phalMfdf functions of the NxpRdLib to retrieve the token and is independent of
the underlying implementation of PAL and HAL layers.

Before phalMfdf functions can be used one must instantiate and configure the NxpRdLib stack.
This action is performed in smart_lock_init_mfdf function, which takes pointer to PAL and HAL
layers.

In case you would like to change the card type from MIFARE DESFire to some other card from
MIFARE family these two functions (smart_lock_init_mfdf and smart_lock_retrive_token)
should be replaced.

After the token is retrieved it is passed to smart_lock _process_token function which in turn
validates its content and perform the correct action (error/door opening).

12.2 Task CLIF

Task CLIF is implemented in the smart_lock_task_clif.c. It uses standard NxpRdLib to initialize
the RFID reader chip and set up the correct NxpRdLib stack.

The task uses a timer to schedule itself. When timer lapses it initializes the discovery loop to
search and activate 1ISO14443 Type A cards (with smart_lock_clif_init_discovery loop) and run
the discovery loop. If valid target gets activated the correct PAL needs to be initialize and then
we can perform the token retrieval.

The poll loop is performed a finite number of times. Number of tries and time in-between can
be set in smart_lock_cfg.h by setting:
e SMART_LOCK CFG_TIMER_WAKE_UP_COUNT — how many times we should poll
¢ SMART_LOCK_CFG_TIMER_WAKE_UP —time in-between polls

4. Task CLIF NxpRdLib component stack for activation:
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phhalHw Nfc Ic_DataParams t

phacDiscLoop_Sw_DataParams_t phpall14443p3a_Sw_DataParams_t

phpalll4443pd4a_Sw_DataParams_t
phpall14443p4 Sw_DataParams t
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5. Task CLIF NxpRdLib component stack for communication:

phhalHw_Nfc Ic_DataParams t

phpall14443p4 Sw_DataParams t

phpalMifare_Sw_DataParams _t

phalMfdf_Sw_DataParams_t phKeyStore _Sw_DataParams_t

phCryptoSym_Sw_DataParams_t

phCryptoRng_Sw_DataParams_t

12.3 Task HIF
Task HIF is implemented in smart_lock task_hif.c. After the task starts it initializes custom
BAL and HAL layers that implement QN < PN communication protocol. Next it tries to
perform the handshake between the QN and PN. When the handshake is successfully
performed it initialize the custom PAL layer, which is used to initialize NxpRdLib software
stack and then perform the token retrieval.

12.3.1 Task HIF NxpRdLib component stack:

phbalReg_Smart Lock DataParams_t

phhalHw_Smart Lock _DataParams _t

phpalMifare_Smart Lock _DataParams_t

phalMfdf _Sw_DataParams_t phKeyStore_Sw_DataParams_t

phCryptoSym_Sw_DataParams_t

phCryptoRng_Sw_DataParams_t

12.3.2 phbalReg_Smart Lock _DataParams_t

phbalReg_Smart Lock _DataParams_t component can be found at
comps/phbalReg/src/Smart Lock Serial/phbalReg_Smart Lock Serial.c. The file contains
the low level implementation of the communication protocol.

12.3.3 phhalHw_Smart Lock DataParams_t

phhalHw_Smart Lock _DataParams_t component can be found at
comps/phhalHw/src/Smart Lock /phhalHw_Smart Lock .c and implements the
phhalHw_Smart Lock _Exchange function with buffering and manipulation of the data for
upper layers.

12.3.4 phpalMifare_Smart Lock _DataParams_t

phpalMifare_Smart Lock _DataParams_t component can be found at
comps/phpalMifare/src/Smart Lock /phpalMifare_Smart Lock .c and is a wrapper used by
the upper layers.
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12.4 Configuration options for PN firmware

PN firmware can be configured in different ways by means of defines in smart_lock cfg.h
in the following ways:

e Cryptographic algorithm configuration options:
° SMART_LOCK_CFG_AUTH_2KTDES
°  SMART_LOCK_CFG_AUTH_3KTDES

> SMART_LOCK_CFG_AUTH_AES
o Key diversification: SMART_LOCK_CFG_AUTH_DIVERSIFY

13. Firmware flashing

13.1 Requirements

For developing PN7462AU and QN9021 firmware and customer applications all
components listed in the below table are required.

Table 1. Development environment

Iltem Version Purpose

OM27462NBR Smart Lock KIT 1.2 or higher Demonstrator board
OM13054 LPC Link 2 1.0 Standalone debug adaptor
LPCXpresso IDE 8.0.0 or higher Development IDE for PN

LPCXpresso PN7462AU plugin | com.nxp.pn7xxxxx.update | Add PN7462AU reader to the
-8.0.0-SNAPSHOT-150 LPCXpresso

5.21 or higher Development IDE for QN

ARM Keil MDK

1.3.9 or higher Plugins for Keil and optional for

QN9020QBIlue Software tools flashing via serial port

For an example of how to use LPCXpresso to update the PN7462 firmware refer to the
following document: UM10883 — PN7462 family Quick Start Guide Development Kit.

13.2 LPC-Link2 connection

On the SmartLock board there are two SWD connections for upgrading both the PN7462
and the QN9021 firmware. The SWD/JTag connectors are marked with PN SWD and
Bluetooth Low Energy SWD. The LPC-Link2 board can be used to flash the PN7462AU
and QN9021. In Fig 18 the pins of the flashing cable are marked according to the pins on
the SmartLock.
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Fig 18. LPC Link2 SWD connection cable

13.3 Flash new firmware on PN
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Install LPCXpresso IDE and activate the free edition under
Help—> Activate>Activate (Free Edition)

Install LPCXpresso PN7462AU plugin

Import the Smartlock PN Project via File=>Import->Existing Project into
Workspace

Build the Project via Project->Build All. Additional compiler may need to be
installed based on your environment.

Connect the LPC Link2 and the Smartlock PN SWD Pins with the flashing cable
to the correct pins as shown in Fig 18.

Make sure the JP2 jumper on the LPC-Link 2 is set and the Battery is connected
to the Smartlock.

Click the Program Flash icon to flash the PN software. If there is a
CoreException shown when connecting with the LPC-Ling 2 then ignore it.

For further questions have a look into UM10883 — PN7462 family Quick Start
Guide Development Kit..
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13.4 Flash new firmware on QN
13.4.1 Flash with LPC Link 2

Install ARM Keil MDK

Install the QN9020QBIue Software tools

Run the QN9020DevDBforIDE tool to install the Keil QN Device Database
Open the QN Project in Keil via Project->Open Project

Build the Project via Project->Build Target

Connect the LPC Link2 and the Smartlock QN SWD Pins with the flashing cable to
the correct pins as shown in Fig 18.

Make sure the JP2 jumper on the LPC-Link 2 is set and the Battery is connected to
the Smartlock.

Open LPCXpresse IDE and click the flash icon to ensure that the LPC-Link2 is
operating in the correct mode.

Now switch back to Keil and click Project->Options for Target ‘smartlock’. A new
Window should open.

Under Device the previous installed NXP Bluetooth Low Energy CLU Database as
shown in with the flashing cable to the correct pins as shown in Fig 19 has to be
selected.

T

De\ﬂcel Target I Outputl Llstlngl User I CfC-I—I-I Asm I Llnkerl Debug

r—Corfigure Flash Menu Command

% Use Target Driver for Flash Programming [~ Use Debug Driver
ICMSIS-DAP Debugger LI Settings | ¥ Update Target before Debugging
it Fie: | e |
" Use Extemal Tool for Flash Programming
Command:l _I
ﬂrguments:l

I~ Run Independent

—Corfigure Image File Processing (FCARM):
Qutput File: Add Output File to Group:

startup LI

Image Files Root Folder: I [ Generate Listing

Fig 19. Option for Target in Keil

In the Debug settings under “Use” select CMSIS-DAP Debugger and click on Settings.
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A new Window should open and show the SW Device in the List. Device Name should
be “ARM CoreSight SW-DP” as in Fig 20.

Cortex-M Target Driver Setup 8 O e ome e [

Debug ITlElce | Fiash Download |

CMSIS-DAP - JTAG/SW Adapter — — SW Device

[LPC-LINK2 CMSIS-DAP V5.1 ~ | IDCODE | Device Name [ iz
SWDIO | {2 10BB11477  ARM CoreSight SW-DP
Serial No: [JaDQGOEU ® . o]
Fimmware Version: |1 ] MI
v 5w F'OI‘tZISW vI & futomatic Detection |D CODE: I
£ Manual Configuration Dievice Mame I
Max[]ock:l‘IMHz "I
sdd | | Detete | | Updae | AP: [000
— Debug
Connect & Reset Options Cache Options Download Options
Connect: |Nomnal ~_v| Reset:[Atodetect  ~| | | ¥ Cache Code I™ Verfy Code Download
[¥ Reset after Connect ¥ Cache Memory | | [~ Download to Flash
[” Stop after Resat
[ ok || cance | Help

Fig 20. Configure Debug Adapter in Keil

Also ensure that CMSIS-DAP Debugger is selected as Target Driver in the Utilities
Settings and the Settings are matching with the Fig 20.

UM11038
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—Corfigure Flash Menu Command

Device I Target I Outputl Listing I User I C."C-I—l—l Asm I Linker I Debug

¥ |Use Target Driver for Flash Programming

[ Use Debug Driver

{CMSIS-DAP Debugger

Init File: I

™ |ze Bxdemal Tool for Flash Programming

LI Settings | [ Update Target before Debugging
| e |

Command :I

=

Arguments:l

[~ Run Independent

—Configure Image File Processing (FCARM):

Cutput File:

Add Cutput File to Group:

startup

Image Files Root Folder: I

[” Generate Listing

o ]

Cancel |

Defaults |

Cortex-M Target Driver Setup =~ % e e

Debug | Trace Flash Download I

— Download Function RAM for Algorithm
Loap ;¥ Program
Fg € EreseSectos W Verdy Start: [10000000  Size: [(x8000
" DonotEmse | Resetand Run
— Programming Algorithm
Description | Device Size | Device Type | Address Range |
QNS020 64kB Fash 6k Ext. Flash SPI 10000000H - 1000FFFFH
Start: | Size: |
Add | Remove |

Help

Fig 21. Configure Utilities in Keil

Save the settings with OK. Now you should be able to flash the QN via Flash->Download

UM11038
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Optional it is also possible to flash the QN via a serial port. Remove the PN Core module
and connect your serial port with the QN as shown in the Fig 22.

Fig 22. Connections for serial flashing

Open the QBlue ISP Studio and check that the settings matching the Fig 23.

Click the Start button to start the flashing procedure. The tool waits until the QN goes in a
reset to allow flashing. Simply remove and connect the supply to trigger a reset.

-
() QBlue ISP Studio

[ Download Configuration File
7| Download Data File

Verify

[~ Flash Lock

[Flora

Data Addr  0x10000

Status

Device is not connection

= L=k
Help Options
Parameters File
Application
-
Crystal MHz Jownrloads\bin-smartlock_20160910_release.bin
MNVDS Configuration
Interface UART
-
COM Part coMg -
Data
Baudrate 115200 ~
-
App Location [FLASH » Options
Download Application File

Start

Fig 23. Options for serial flashing
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14.1 Overview

14.2
14.2.1

14.2.2

14.2.3

Harmonized data structure for all credential types

SMART LOGK DEMO [111E)

« PICC
@ s s PICC = Card mgt. level of card (only for card)
B Qe ApplD
= Application identifier
App|D = Lock checks for ApplD

E— . Unique per customer (hotel) / solution provider
=  Mobile use case:
010110 . i i i i
L__\ 110011 Data File *  Name of adve_rtlsed service (BLE) resp. registration 1D
101000, for HCE solution
0

* Binary File
= Contains token
Read only configuration

Fig 24. Harmonized data structure

MIFARE DESFire card configuration

Application configuration:
Application Master Key Setting:
0x0B (Change App Key, GetFile enabled, master key changeable)

Application Key settings:
= APPID: 010203
= Crypto Mode: AES
= DF-Name: 07060504030201 (HEX)
= 3keys
» Key 0 app Master key
« Diversified Key needed
* Non-diversified Key: 00000000000000000000000000000001
¢ Key 1 Read key for File id 00
« Diversified key needed
* Non-diversified Key: 00000000000000000000000000000000
« Key 2 No rights only used for GetCardUID command
* No diversification
+ Key: 00000000000000000000000000000000

Symmetric key diversification details see application note AN10922

14.2.3.1 Input for diversified Key

e 0x01 // fixed start constant not needed in reader library

o OXXX OxXX OxXX OxXX OxXX 0xXX OxXX /[l XX = 7 byte Card UID

» 0x01, 0x02, 0x03, // 3 byte AID fixed

« 'S,'M,'AL'R, T, 'L, 'O 'CY 'K T 9 byte ASCII to HEX fixed

» Together fixed start constant + 19 byte diversification input
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14.2.4 Standard Data File settings

File ID: 0x00

Supported Communication Modes

e Fully Encrypted

Access rights: 0x1000

* Key #0 for write, R&W, Change Access rights
* Key #1 for read

File size: 0x000080 (Size: 128 bytes)

14.3 Standard Data file content
14.3.1 Token format

OxAB

0xDO

0xD1
0xD3

0xD5

0x68

0x10

0x04
0x0C

0x40

Total data length

2-byte label [==0x00 00]

1-byte token version [0x01]

4-byte issuer |ID [0xCA FF EE 00 ==AID]

4-byte time stamp from - Unix timestamp in seconds
4-byte Unigque sequence number [Random No.]
1-byte ECC-P26 key version [0x01]

4-byte time stamp until - Unix timestamp in seconds

4-byte Hotel ID [0x47 52 41 5A]

ECC-P256 signature

4-byte Room ID [0x30 32 30 31 “0201” or 0x30 32 30 32 “202”]
4-byte RevToken for revoking of previous tokens [0x00 00 00 01]

14.3.2 Token verification process

UM11038
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1. Validate Revroken = chose appropriate processing

Nookwd

If revision is below current Rev in lock = Token isn’t valid anymore

If revision is equal to current Rev in lock = no actions
If revision is higher than current Rev in lock = increase Lock Rev

Validate Time stamps

Validate HotellD/RoomID -> correct lock number?

Validate Revrevoke = can be used for offline blocking of “lost card”
Validate Revecckey = chose appropriate ECC public key

Verify ECC signature

Read Unique sequence number [Random No.] and store in log-file
- which token has been used
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15. Power consumption figures

The above table shows different power consumption figures based on Bluetooth Low

Low Power Mode Adv Interval Transmit Power Current Consumption
19 pA

37 pA

~ 93 pA

~ 107 pA

~ 155 pA

~ 170 pA

Energy advertising intervals. The current QN firmware implementation is configured for
600ms -14 dBm.

at around 93 pA while advertising.

16. Power optimization considerations

At present the Bluetooth Low Energy is operating in polling mode and advertises every
600ms. In order to further reduce the average power consumption, one might consider
changing the hardware and software design in a way that the Bluetooth Low Energy
circuitry is also woken up by an external trigger such as the capacitive wakeup sensor.
Care must be taken to ensure proper RTC (real time clock) operation of the QN9021 in
this case.

Note: the KIT s hardware and software are delivered as is. Any modifications on this
hardware and/or software are not in the responsibility of NXP.

17. Download available Documents and firmware
www.nxp.com/demoboard/OM27462NBR

18. References

[1] LPCXpresso webpage
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19.1 Definitions

Draft — The document is a draft version only. The content is still under
internal review and subject to formal approval, which may result in
modifications or additions. NXP Semiconductors does not give any
representations or warranties as to the accuracy or completeness of
information included herein and shall have no liability for the consequences
of use of such information.

19.2 Disclaimers

Limited warranty and liability — Information in this document is believed to
be accurate and reliable. However, NXP Semiconductors does not give any
representations or warranties, expressed or implied, as to the accuracy or
completeness of such information and shall have no liability for the
consequences of use of such information. NXP Semiconductors takes no
responsibility for the content in this document if provided by an information
source outside of NXP Semiconductors.

In no event shall NXP Semiconductors be liable for any indirect, incidental,
punitive, special or consequential damages (including - without limitation -
lost profits, lost savings, business interruption, costs related to the removal or
replacement of any products or rework charges) whether or not such
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associated with their applications and products.

NXP Semiconductors does not accept any liability related to any default,
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19.4 Trademarks

Notice: All referenced brands, product names, service names and
trademarks are property of their respective owners.

MIFARE — is a trademark of NXP B.V.
DESFire —is a trademark of NXP B.V.

Bluetooth — The Bluetooth word mark and logos are registered trademarks
owned by Bluetooth SIG, Inc. and any use of such marks by NXP
Semiconductors is under license.
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AMBA, Arm, Arm7, Arm7TDMI, Arm9, Arm11, Artisan, big.LITTLE,
Cordio, CoreLink, CoreSight, Cortex, DesignStart, DynamIQ, Jazelle,
Keil, Mali, Mbed, Mbed Enabled, NEON, POP, RealView, SecurCore,
Socrates, Thumb, TrustZone, ULINK, ULINK2, ULINK-ME, ULINK-PLUS,
ULINKpro, pVision, Versatile — are trademarks or registered
trademarks of Arm Limited (or its subsidiaries) in the US and/or elsewhere.
The related technology be protected by any or all of patents, copyrights,
designs and trade secrets. All rights reserved.
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